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Abstract

The importance of 3-dimensional (3D) topography in influencing neural stem and progenitor cell (NPC) phenotype is widely acknowledged yet
challenging to study. When dissociated from embryonic or post-natal brain, single NPCs will proliferate in suspension to form neurospheres.
Daughter cells within these cultures spontaneously adopt distinct developmental lineages (neurons, oligodendrocytes, and astrocytes) over the
course of expansion despite being exposed to the same extracellular milieu. This progression recapitulates many of the stages observed over
the course of neurogenesis and gliogenesis in post-natal brain and is often used to study basic NPC biology within a controlled environment.
Assessing the full impact of 3D topography and cellular positioning within these cultures on NPC fate is, however, difficult. To localize target
proteins and identify NPC lineages by immunocytochemistry, free-floating neurospheres must be plated on a substrate or serially sectioned.
This processing is required to ensure equivalent cell permeabilization and antibody access throughout the sphere. As a result, 2D epifluorescent
images of cryosections or confocal reconstructions of 3D Z-stacks can only provide spatial information about cell position within discrete physical
or digital 3D slices and do not visualize cellular position in the intact sphere. Here, to reiterate the topography of the neurosphere culture and
permit spatial analysis of protein expression throughout the entire culture, we present a protocol for isolation, expansion, and serial sectioning
of post-natal hippocampal neurospheres suitable for epifluorescent or confocal immunodetection of target proteins. Connexin29 (Cx29) is
analyzed as an example. Next, using a hybrid of graphic editing and 3D modelling softwares rigorously applied to maintain biological detail, we
describe how to re-assemble the 3D structural positioning of these images and digitally map labelled cells within the complete neurosphere. This
methodology enables visualization and analysis of the cellular position of target proteins and cells throughout the entire 3D culture topography
and will facilitate a more detailed analysis of the spatial relationships between cells over the course of neurogenesis and gliogenesis in vitro.

Both Imbeault and Valenzuela contributed equally and should be considered joint first authors.

Video Link

The video component of this article can be found at https://www.jove.com/video/2483/

Protocol

1. Isolation of Neural Progenitor Cells

Keep tissues and solutions cold at all times during isolation protocol!

1. Prior to starting your cultures, prepare the following stock solutions:
• Dissociation media (26 mM NaHCO3, 124 mM NaCl, 5 mM KCl, 0.1 mM CaCl2*2H2O, 3.2 mM MgCl2*6H2O, 10 mM D-glucose, 100 U/

mL penicillin, 100 μg/mL streptomycin. Sterile filter and store in 10-15 mL aliquots at -20°C. Prepare stock concentrations of enzymes
used for cellular dissociation in double distilled H2O, sterile filter and store aliquots at -20°C: Neural protease (25 mg/mL), papain
(10 mg/mL), DNAseI (10 mg/mL). On the day of the experiment, add enzymes to 15 mL of Dissociation Media at the following final
concentrations: 1 mg/mL protease, 0.1mg/mL papain, 0.1 mg/mL DNAse I. Dissection solution containing final enzyme concentrations
can be kept on ice during the dissection process.

• Maintenance Media: Dulbecco's modified Eagle's medium F12 (DMEM/F12), 2 mM L-glutamine, 100 U/ml penicillin,100 μg/mL
streptomycin, 1X B27 supplement. Can be kept for up to 3 months at 4°C without B27 supplement and up to one month at 4°C with
B27 supplement.

• Growth factors: Prepare stock aliquots of 0.1 μg/mL human recombinant epidermal growth factor (hEGF) and 10 μg/mL fibroblast
growth factor-2 (FGF-2) in DMEM/F12 + 0.1% bovine serum albumin (BSA). Store at -20°C.

2. To lethally anesthetize C57BL/6 mouse pups, mice are injected intraperitoneally with Euthansol on postnatal day 0-3.
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3. Carefully remove brains by standard dissection and store in a 60 mm dish containing artificial cerebrospinal fluid (ACSF: 26 mM NaHCO3,
124 mM NaCl, 5 mM KCl, 2 mM CaCl2*2H2O, 1.3 mM MgCl2*6H2O, 10 mM D-glucose, 100 U/mL penicillin, 100 μg/mL streptomycin). pH to
7.3 if necessary and sterile filter into 50 mL aliquots, store at -20°C.

4. Using a razor blade, block brain by removing the cerebellum and glue brain with Krazy Glue, rostral side up, dorsal side facing you, onto the
vibratome chuck. A Leica Microsystems VT1000S vibratome is used in this protocol.

5. Position chuck in the vibratome and add ACSF and ice into the proper compartments.
6. Cut slices of 500 μm thicknesses using a speed between 3.5-4.5 and frequency of 8.5.
7. Collect slices containing the hippocampal formation in dishes containing ACSF.
8. Using a stereomicroscope, remove hippocampi between bregma -1.60 mm and -2.40 mm (until the CA3 region starts to curve ventrally) and

place in a new dry dish (without ACSF). A Leica MZ6 dissecting microscope is used in this protocol.
9. Once all hippocampi are collected, mince tissue with a scalpel (until a homogeneous and liquefied appearance is achieved).
10. Transfer minced tissue to a 15 mL polypropylene tube containing 2.5 mL Dissociation media containing neural protease, papain, and DNAse

I (see step#1 for solution preparation). Note if there is a lot of source tissue (e.g., from 6 pups) it is a good idea to use 2 vials of 2.5 mL
dissociation media to maintain optimal enzyme:tissue ratio. Incubate at 37°C for 45-60 min with rotation. A Labnet ProBlot 6 hybridization
oven (purchased through Mandel Scientific) is used in this protocol set to rotation setting 4.

11. Add 10 mL of sterile tissue culture potassium phosphate buffered saline (kPBS: 137 mM NaCl, 2.7 mM KCl, 10 mM phosphate buffer, pH 7.4)
and centrifuge at 300 x g for 5 min. An Eppendorf centrifuge (model 5702) is used in this protocol.

12. Discard supernatant and resuspend pellet in 5 mL of kPBS.
13. Dissociate tissue by trituration through a Pasteur pipette.
14. Centrifuge cell suspension at 300 x g for 5 min.
15. Resuspend cells in 3 mL of Maintenance medium, count cells using Trypan Blue and plate cells in 60 mm non-adherent dishes (Corning

Ultra-Low adherence binding dishes are used in this protocol, see Materials) at a density of 2.5 x 105 cells/dish in 5 mL of maintenance
medium. Petri dishes can be used in place of Ultra-Low adherence dishes but cultures will require to be tapped in the morning and afternoon
every day during expansion for the first 6 days in vitro (DIV) to prevent plating and spontaneous differentiation.

16. Add hEGF to a final concentration of 20 ng/mL and FGF-2 to a final concentration of 10 ng/mL immediately after plating. Add additional
growth factors every two days during the expansion phase until collection day on DIV 14. (Scale bars in video of expanding neurospheres
represent 100 μm.)

**Note: media may become yellow around DIV 10 of the expansion phase. If this occurs, add another 1 mL Maintenance media. If media is again
yellow the following day, add another 1 mL of Maintenance media - keep doing this as necessary during your expansion phase - remember to
adjust volume of growth factors accordingly to maintain the correct final concentrations.

2. Serial Cryosectioning

1. Tap neurospheres gently prior to fixation to ensure spheres are well-separated at time of fixation.
2. Add molecular grade formaldehyde directly to the cultures to a final concentration of 3.7% and incubate at room temperature (RT) for 20 min

with slow shaking. A Stovall Belly Dancer is used in this protocol set to a rotation speed of 2.5.
3. Collect neurospheres in a 15 mL polypropylene tube and spin down at 300 x g for 5 min.
4. Discard supernatant and resuspend pellet in 10 mL sodium phosphate buffered saline (nPBS: 154 mM NaCl, 10 mM phosphate buffer). Note

the change in solution usage from kPBS to nPBS.
5. Spin down at 300 x g for 5 min.
6. Resuspend in 5-10 mL 20% sucrose (w/v) solution in nPBS.
7. Keep neurospheres at 4°C for at least 24 h to cryoprotect cultures.
8. Fill a disposable cryomold with Optimal Cutting Temperature (OCT) Compound.
9. Gently pour the sucrose solution containing neurospheres into a dish.
10. Use a stereomicroscope to locate representative spheres of various sizes with the least evidence of mechanical disruption. When performing

this procedure for the first time, some cultures may be broken or torn. Morphology will be nicely maintained with practice.
11. Gently aspirate each neurosphere up into a 1 mL pipette tip (keep the volume of sucrose containing-solution removed to a minimum) and

place it into the OCT compound. Mark your approximate location on the mold so you can find the spheres later.
12. Once you have placed a few spheres into the cryomold, flash-freeze the samples using CO2 until OCT is white.
13. Mark the location of your spheres on the cube and pop the cube out of the mold
14. Using pre-chilled forceps, place the cube onto a piece of filter paper previously secured to a chuck with OCT.
15. Place more OCT compound around the cube and freeze to adhere the block containing the spheres using CO2. Alternatively place the chuck

(with filter paper) in the cryostat, squirt OCT compound onto filter paper, and place cube directly into OCT. Wait until OCT is white and hard. A
Leica CM1900 cryostat is used in this protocol.

16. Once the OCT compound becomes white, you may place the chuck onto the cutting block, then wait at least 30 min for the temperature to
equilibrate.

17. Cut serial 10 μm sections looking out for your marks and checking often under a microscope for neurosphere sections. Place as many
sections as you can onto one slide. Note you may not be able to see the first few slices of your neurosphere under the scope, so collect all
sections until you see cells and keep the 3-5 sections before this start and at the end of your sphere. These anterior and posterior sections
will also be processed for immunocytochemistry. A nuclear counterstain when performing immunostaining is therefore key as it will allow you
to detect single cells at the neurosphere poles not readily apparent under standard inverted phase microscopy.

18. Store sections at -20°C.

3. Immunocytochemistry

1. Remove slides from -20°C and thaw by applying nPBS gently over all sections and incubating at RT for 5 min.
2. Flick off excess nPBS and immediately apply primary antibody diluted in Ab buffer (0.3% Triton X-100, 0.3% bovine serum albumin in nPBS,

pH 7.2). You will need ~100 μL per slide. In this protocol, we localize Cx29 in discrete NPC progeny present in 3D neurosphere culture.

https://www.jove.com
https://www.jove.com
https://www.jove.com


Journal of Visualized Experiments www.jove.com

Copyright © 2010  Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

December 2010 |  46  | e2483 | Page 3 of 6

3. Cover with parafilm cut to cover the sections but not to exceed the size of the microscope slide as antibody will be drawn off the slide by
osmosis if the parafilm reaches or exceeds the width of the slide. The parafilm will prevent evaporation. Incubate overnight at 4°C in a humid
chamber. Take care to float the parafilm over the sections and do not allow it to adhere to the slide. However, do not remove or alter the
parafilm placement once applied as care must be taken not to apply any shear force on the sections and thereby disrupt morphology.

4. Add ~1 mL nPBS directly to sections and float off the parafilm. Alternatively, place the slide vertically directly in a coplin jar until the parafilm
floats away. Do not remove the parafilm until it floats away independently of manipulation as you may disrupt fragile neurosphere structure.
Once the parafilm is off the slide, incubate 5 min at RT. Flick off nPBS and continue with 3 more washes at RT for 5 min.

5. Apply secondary antibody diluted in Ab buffer and incubate at RT for 1 h in a humid chamber as described above. You will again require ~
100 μL/slide.

6. Repeat nPBS washes in step 4. Apply a nuclear counterstain in the 3rd wash (Hoechst 33258 0.5 μg/mL in nPBS) for 5 min and proceed with
the final wash for 5 min at RT.

7. Mount in your preferred anti-fade mounting media and coverslip, securing the coverslip with nailpolish first in the corners then all around the
edges to prevent loss (if using a glycerol-based media).

8. Proceed to image collection using an epifluorescent or confocal microscope. In this protocol, we use a Leica DMRA2, a Hamamatsu Orca ER
camera, and OpenLab v3.56 software. In this example, images are captured on three channels: (1) Phase-contrast, (3) Blue UV (Leica A4
cube: Filter combinations Ex 360/40, Di 400, Sp BP470/40), and Red (Leica Y3 cube: Filter combinations Ex BP535/50, Di 565, Sp 610/75).
Shoot each serial section paying close attention to the first and the last sections by tracking the poles using Hoechst 33258 labelling of DNA
where phase detection of single cells is difficult.

4. Alignment

1. When the cryosections are thaw-mounted onto the microscope lines, they will move and rotate very slightly. These deviations must be
corrected. Moreover, when each serial section is imaged, the centre of each image may not be in the same location on the screen. As a
result, each digitized serial section must be carefully realigned with the preceding section to preserve accurate morphology. This alignment
requires a careful and precise attention to cytoarchitecture and topographic detail.

2. Serial images of each channel and resident scale bars of 10 μm and 50 μm (established in OpenLab v3.56 software) are saved as individual
TIFF files and imported into Photoshop CS4 using a standard canvas size of 3300 x 2550 pixels and a resolution of 72 pixels/inch. Careful
attention to canvas size must be taken in this import to maintain an accurate scale. The canvas size and resolution are key to subsequent
modelling in Maya. The scale bar, saved as a separate layer in Photoshop, should be used to verify that no change to the X-Y dimensions
occurs during the alignment in Photoshop.

3. Next, link the three (or more) layers corresponding to the same section (i.e., link each phase, UV, and Cy3 image series for each section).
This assures that when one layer is aligned, other layers associated with that section are also aligned at the same time. Alternatively, you can
lock the phase layer once in the appropriate position (see below) and then align the associated layers of that section to the phase layer.

4. To begin, make all layers invisible by clicking the "eye" icon in the layers window.
5. Turn the first and second phase contrast images of the neurosphere serial sections on by clicking on the "eye" icons in the layers window.

Increase the transparency of the second section. Under the "Image" tab, open "image rotation" and choose "arbitrary." Rotate the second
section until you are able to identify points of geometric and structural contiguity between images. It is helpful to compare back and forth with
the UV channel (Hoechst 33258-labelled sections).

6. Repeat for all subsequent serial sections comparing "nearest neighbours" (i.e., the immediate anterior section with the immediate posterior
section) until all sections and all channels are accurately aligned.

7. Create a plane in Maya v10 that is of the same proportions as the Photoshop file.

5. Cell Typology

1. From the Status Line of Maya's user interface, change the Menu Bar from its default Animation setting to Surfaces.
2. Use a primitive subdivision sphere to create the cell body.
3. With the neurosphere selected, begin manipulating its vertices by clicking the right mouse button on the object and selecting Vertex from the

Marking Menu. Further elaborate the surface of the sphere by changing the Display Level from the Marking Menu.
4. From the Subdivision Surfaces tab of the main menu, open the Collapse Hierarchy options box and set the number of levels to 2. Collapse

the sphere.
5. Change the Menu Bar from Surfaces to Polygons.
6. With the sphere selected, open the Sculpt Geometry Tool from the Mesh tab of the main menu.
7. Refine the surface of the cell to its final form employing the Sculpt Geometry toolset from the Tool Settings tab.
8. Repeat this process to create different cell bodies to simulate the variety of NPCs and NPC progeny present in the neurosphere. In this

demonstration, ten different cell bodies form the basis for the neurosphere.
9. Select the cell typology and Freeze Transformations.
10. With the cells of your typology established, two surface shaders will be designed to represent both cells expressing the protein of interest

(in our example Cx29-positive cells) and cells where the protein is absent. Here, any cell with Cx29 immunoreactivity is designated Cx29-
positive. In this example, subcellular localization is not modelled although such an analysis is possible with modifications to the shaders.

11. Open the Hypershade window from the Windows > Rendering Editors tab of the main menu.
12. Choose a Ramp Shader from the Surface materials tab.
13. Open the Attribute Editor and set the shaders Color, Incandescence, Ambient Color, Bump Map, and Specular Color attributes.
14. Assign a Brownian 3D Texture to the Ambient Color node and a 2D Fractal texture to the Bump Mapping node.
15. Select the resultant shaders Input and Output Connections and export the selected network.
16. Select the cell typology and open the Export Selection options box.
17. Choose the file type mayaAscii and uncheck the Include these inputs box. Export Selection.
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6. Cell Mapping

1. Open the aligned serial sections file in Photoshop CS4.
2. Establish a key of Pencil strokes to mark the locations of each progenitor cell in the serial sections. In this demonstration, a key of three

strokes - a solid square, a square with a dashed line, and a square with a cross - will be used to indicate whether a cell is located in one,
two, or three sections. This key of strokes is further defined by color - in this example, red represents cells expressing our protein of interest,
Cx29, and white represents cells not expressing Cx29.

3. Turn the Phase layer on and begin marking the centre of each progenitor cell with a white Pencil stroke. Use a separate layer within the
section folder with which to build your maps.

4. Toggle between sections to locate the cells position ensuring that cells on more than one section are properly denoted.
5. With the Cx29 layer turned on, select the cells that fall in the regions where Cx29 is positively expressed.
6. Choose the Fill command from the Edit tab of Photoshop's main menu bar and change the white strokes to red.
7. With the maps completed, save each section as a separate jpeg image in the sourceimages folder of the Maya project. To do this, a new

Maya project will first have to be created.

7. Importing and Assembling Maps in 3D

1. From the Status Line of Maya's user interface, change the Menu Bar from its default Animation setting to Polygons.
2. Import the planes.mb and scaleBar.mb files from the projects scenes folder.
3. With the plane selected, assign a Lambert shader by clicking the right mouse button on the object and opening the Assign New Material tab.
4. In the Attribute Editor click the chequered box to the right of the materials Color attribute.
5. From the pop-up menu, choose File from the 2D Textures section.
6. Under the File Attributes section in the Attribute Editor, click the file icon to the right of the Image Name attribute.
7. Choose the first section from the sourceimages folder.
8. Switch the camera of the Workspace window from the Perspective view to the default orthographic Top view by opening the Panels tab.
9. Select the Create Polygon Tool from the Mesh tab of the main menu and trace the outline of the section.
10. Choose the first map from the sourceimages folder and assign it to the newly created polygon plane following the steps established to create

the polygon plane.
11. With the object selected, choose UV from the Marking Menu by clicking the right mouse button over the plane.
12. Select all the planes UV points and open the UV Texture Editor from the Windows tab of the main menu.
13. Scale the proportionally of the UV to fit the section plane.
14. Repeat this process for each section of the neurosphere ensuring that the spaces between each section correspond to the height of the scale

bar.

8. Locating Progenitor Cell Typologies in 3D

1. From the Status Line of Maya's user interface, change the Menu Bar from its default Animation setting to Dynamics.
2. Leaving only the first section of the neurosphere visible, hide all other sections by changing the display settings from the Display tab of the

main menu.
3. With the CV Curve Tool's options box open, select 1 Linear from the CV Curve Settings.
4. Viewing the scene from the Top view camera, begin assigning points to the cell maps creating one curve for the Cx29-negative cells and one

for the Cx29-positive cells.
5. The resultant curves are flat when viewed from a Side view camera. Establish the thickness of the sections by shifting the points of the curve

in the y-axis using the scale bar imported from the microscopy images as a guide.
6. Repeat this process for each section of the neurosphere.
7. Import the cellTyoplogy.ma file from the scenes folder of the project and duplicate the cell typology for both the Cx29-negative and Cx29-

positive cells within the neurosphere.
8. Open the Hypershade window from the Windows > Rendering Editors tab of the main menu.
9. Import the previously built shaders assigning them to the cells of the typology.
10. From the Outliner Window, remove the file name from beginning of the imported objects. This will become important in later stages of the

modelling process.
11. Select the Particles tab from the main menu and create a particle emitter for the first CV Curve.
12. Open the particleShape1 tab and under Emission Attributes change the Max Count from -1 to the number of points on your first curve.
13. In the Render Attributes tab change the Particle Render Type to Blobby Surface (s/w). Click on the Current Render Type box below and

change the Radius of the particles 0.010.
14. Attach the particles to the vertices of the curve by first selecting the particles then shift selecting the curve. Open the Goal options from within

the Particles tab of the main menu and set the Goal Weight to 1. Click Create.
15. Select the cells from number 1 to 10 in order in the Outliner Window and open the Instancer (Replacement) options box from the Particles tab

of the main menu. In the Instance Objects box, all ten cells should be listed in order.
16. Choose the correct particleShape name from the drop down list of the Particle Object to Instance tab. Click Create.
17. By default, only the first cell that was selected will replace the particles along the curve. In order to get all ten types to appear and cycle

randomly among the particles, an expression is needed. A second expression will ensure that the cells emit randomly in the same way every
time the Range Slider is repositioned.

18. With the emitter selected, open the Attribute Editor. In the particleShape tab, under Add Dynamic Attribute click on the General box. Under
Long Name write random_index. In Attribute Type switch from Scalar to Per particle (array) and hit Add.

19. In the Per Particle (Array) Attributes tab, a random_index box has been added. Clicking the right mouse button over the empty space, select
Create Expression... from the drop down box.

20. Type the text in the Expression: box - particleShape1.random_index=rand(10); if (particleShape1.particleId==1)seed(1);
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21. To complete the expression open the Instancer (Geometry Replacement) tab in the Attribute Editor and in General Options > Object Index
select random_index from the drop down list. Bring the time slider to the first frame and hit play, the cell types are now randomly distributed
among the particles.

22. Repeat this process for each section of the neurosphere. Ensure that each new emitter, instancer, and random index is differentiated by
name and organized appropriately in the Outliner Window.

9. Rendering / Compositing

1. In the Render Using section of the Render Settings window, change the renderer from Maya Software to mental ray.
2. Open the Quality tab and under Raytracing change the Reflections setting to zero. Open the Framebuffer tab and change the Colorclip from

Raw to Alpha and uncheck Premultiply.
3. Open the Channel Box/Layer Editor and change the Layer Editor setting from Display to Render.
4. Select the imported cells of the typology and click the Create new layer and assign selected objects icon.
5. Rename the layer ambient occlusion.
6. Clicking the right mouse button over the newly created layer, select Attributes from the menu.
7. To the right of the renderLayer box, click on the Presets button and select Occlusion from the drop down list.
8. Select the mib_amb_occlusion1 tab and change the Samples from 16 to 256.
9. Reopen the Channel Box/Layer Editor and under the Options tab, open the Render All Layers options box.
10. Select Composite and keep layers.
11. With the ambientOcclusion layer selected, change it from Normal to Multiply from the drop down box just above the layer list.
12. Render two passes of the neurosphere, once with the ambientOcclusion layer turned on and once with the masterLayer turned on. Save the

images as iff files in the projects images folder.
13. Open both images in Photoshop CS4. Place the ambientOcclusion layer on top of the masterLayer and set it to Multiply. Create a background

and flatten the image.

Discussion

This protocol describes a procedure to culture and serially cryosection post-natal hippocampal NPCs, localize protein expression by
immunodetection, and finally reconstruct and analyze the topographical position of immunopositive cells within the entire 3D neurosphere. By
combining cell biology culture and processing techniques, microscopy imaging (OpenLab, Improvision and other image analysis softwares),
graphic editing software capacities (Adobe Photoshop), and 3D animation and compositing software capacities (Autodesk Maya), we present a
methodology to reconstruct the entire cellular composition of 3D cultures from serial 2D images allowing for the faithful reconstruction of cellular
position and protein expression throughout a neurosphere culture. This protocol can be combined with equal effectiveness to the registration
and reconstruction of epifluorescent thin serial sections or confocal Z-stacks through thicker serial sections. Because clonal expansion of single
NPCs in neurosphere culture recapitulates many of the stages observed over the course of neurogenesis and gliogenesis in post-natal brain,
the impact of its 3D structure represents an important NPC fate determinant in progeny exposed to the same experimental milieu1. Divergence
in lineage and protein expression at the core and periphery of serial neurosphere sections suggests that multiple physical factors including cell
position, mechanical stress, and shear force play important roles in regulating NPC biology2. Moreover, connexin protein expression, analyzed
here, has been shown to change depending upon when NPCs are cultured as 3D neurospheres in suspension or plated on a laminin substrate
with functional connexin-mediated communication altered whether cells are cultured on plastic and substrate or in 3D free-floating cultures3.
The impact of cellular position on NPC fate remains unclear. It is technically challenging to analyze impact of spatial location within 3D culture
on NPC biology given that antigenic assessment of lineage and signalling proteins requires disruption of the 3D architecture to enable cell
permeabilization and antibody access to all cells. Here, we show that a hybrid visualization methodology provides a means of determining
whether certain proteins exhibit unique positional localizations in 3D culture, can be used to infer and test protein function and regulation with
respect to regional localization within the neurosphere, and, perhaps most importantly, provides the positional data required to study the impact
of 3D topography and cellular positioning on NPC fate in 3D culture.
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